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RESUMO

O uso de embarcacgdes de pequeno porte, que podem alcancar altas velocidades, € comum na
regido amazonica. Porém, a atividade de navegacdo segura e sustentavel com esse tipo de
embarcacdo ainda requer estudos que permitam caracterizar 0 Seu comportamento
hidrodindmico. O presente trabalho visa estudar a velocidade de avango e os padrbes de ondas
gerados por uma embarcacéo regional comum no Estado do Amazonas, conhecida como rabeta,
frequentemente utilizada para transporte de percurso curto entre comunidades ribeirinhas.
Primeiro, foram realizados levantamentos em campo para documentar alguns exemplos desse
tipo de embarcacdes. Logo, realizou-se um experimento em escala real selecionando uma
embarcacao representativa como caso de estudo, visando conhecer a velocidade de avanco com
poténcia maxima do motor. Para medir a velocidade, foram utilizados um aplicativo de GPS de
celular e técnicas de processamento de imagens aplicadas a videos obtidos por um drone. Com
esse ultimo foram capturados os padrbes de ondas gerados na &gua. Além do estudo
experimental da velocidade, foi implementado o0 método hidrodindmico do corpo esbelto para
representar o trem de ondas capturado experimentalmente. Os resultados obtidos demonstraram
que a embarcacdo pode alcancar modos de operacdo definidos por um nimero de Froude de
comprimento em torno a 0,5. Assim, define-se que esse tipo de embarcacgéo pode alcancar altas
velocidades, principalmente no regime de operacdo de semi-deslocamento. Além disso, 0s
resultados obtidos pelo drone demonstraram que o uso desse tipo de embarcagdes também pode
gerar trens de ondas que interagem com os bancos de areia ou vegetagcdo proxima ao percurso.
Estudos similares podem ser implementados para conhecer os modos tipicos de operacdo de

diversas embarcacdes regionais.

Palavras-chave: Amazonia. Efeito das ondas. Embarcacdo de alta velocidade. Transporte

regional ribeirinho. Velocidade de avango.
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ABSTRACT

The use of small boats, which can reach high speeds, is common in the Amazon region.
Therefore, safe, and sustainable navigation activities with this type of vessel still require studies
that allow to characterize their hydrodynamic behavior. This work aims to study the speed of
advance and the wave patterns generated by a common regional vessel in the State of
Amazonas, known as a rabeta, frequently used for short-distance transportation between
riverine communities. First, surveys were carried out in the field to document some examples
of these types of vessels. Then, a real-scale experiment was carried out by selecting a
representative vessel as a study case, aiming to determine the forward speed with maximum
engine power. To measure speed, we used a cell phone GPS application and image processing
techniques applied to videos obtained by a drone. With this last, the wave patterns generated in
the water by the boat were captured. In addition to the experimental study of speed, a slender
body hydrodynamic method was implemented to represent the experimentally captured wave
patterns. The results obtained demonstrate that the boat can achieve modes of operation defined
by a length Froude number around 0.5. Likewise, it is defined that this type of vessel can reach
high speeds, mainly in the semi-displacement operation regime. Furthermore, the results
obtained with the drone demonstrate that the use of these types of vessels can also generate
wave trains that interact with the sand banks or vegetation next to the boat path. Similar studies

can be implemented to understand the typical modes of operation of various regional vessels.

Keywords: Amazon. Effect of waves. High speed boat. Riverine regional transport. Forward

speed.
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1. INTRODUCAO
1.1  Descricéo do problema

O Estado do Amazonas é parte da bacia amazonica, a qual possui grandes rios com
muitos afluentes, utilizados diariamente como vias de transporte por meio de diversos tipos de
embarcagdes. Dentre os rios da regido, cabe mencionar o rio Amazonas, que é 0 maior rio em
extensdo e volume do mundo, com mais de seis mil quilémetros de comprimento, possuindo
uma vasta quantidade de afluentes (Araujo, 2014).

As afluentes dos rios da regido amazonica transformam-se em combinacGes de rios,
lagos e igarapés, onde ainda sdo encontrados desafios para documentar e entender as atividades
fluviais da regido. Nas suas margens, € comum encontrar popula¢bes que desempenham
atividades de plantio e pesca e residem em moradias, tanto em terra como flutuantes, que séo
denominadas ‘comunidades ribeirinhas’ (Lira; Chaves, 2016). Dentre os meios de transporte
mais comuns utilizados por essas comunidades podem se mencionar o uso de embarcacdes de
pequeno porte, muitas vezes construidas de forma artesanal por meio de conhecimentos obtidos
pela experiéncia.

O Estado do Amazonas possui um total de 62 municipios, dos quais a maioria pode ser
acessada por embarcacBes. Ou seja, 0 setor hidroviario é bastante movimentado e um dos
principais meios de transporte do estado é o fluvial (Oliveira; Magalhaes, 2022).

As hidrovias existentes no Estado do Amazonas representam 0s principais meios de
comunicacdo entre as comunidades ribeirinhas, onde as embarca¢des podem ser comparadas
com carros e motos, pois muitas vezes sao 0s principais meios de transporte para pequenas e
longas distancias.

Nas atividades comuns do dia a dia dessas populacdes, tais como pesca, comercio, lazer,
e locomocéo entre as comunidades que se formam nas margens dos rios, um dos principais
meios de transporte consiste no uso de canoas e outras embarcacOes de pequeno porte,
construidas principalmente de madeira, fibra de vidro ou aluminio. Tais embarcac¢des costumam
ser equipadas com motores de popa com rabeta (rabeta se refere a um eixo saliente do casco
que conecta o hélice com o motor) ou motores fora de borda.

Além de serem empregadas como meio de transporte, as embarcacOes regionais de
pequeno porte sdo fundamentais para o sustento das comunidades ribeirinhas ja que costumam
ser utilizadas para a pesca, que pode ser exercida para obter alguma fonte de renda ou até mesmo
usada para propria alimentacdo. Sendo muitas vezes esse 0 Unico meio de transporte entre as

comunidades ribeirinhas, as embarcacdes também sdo usadas para o transporte de carga, como
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alimentos, animais de médio a grande porte, além de eletrodomésticos ou materiais de
construcao.

Cabe mencionar que, muitas vezes, as embarcaces utilizadas sdo de pequeno porte e
sem preparo nenhum para o transporte de cargas. O uso constante dessas embarcag0es sem
fiscalizacdo das cargas nem instrumentos de navegacdo pode resultar em acidentes que pdem
em risco a vida das pessoas, como colisBes, naufragios, embarque de agua, emborcamento etc.

Na regido amazonica, € comum que a confeccao das embarcacdes regionais seja feita de
forma semiempirica, onde a experiéncia da construcdo é passada através de geracdes
(Hernandez-Fontes et al., 2021; Lins et al., 2006; Maia et al., 2021). Ainda podem ser
encontradas embarcacdes que passam por um processo produtivo sem certificacdo e,
possivelmente, podem ndo atender os requisitos minimos de operacgéo e seguranca descritas nas
Normas da Autoridade Maritima para Embarcacfes Empregadas na Navegacao Interior —
NORMAM 202 (Marinha-do-Brasil, 2023).

Por outro lado, € comum que as comunidades ribeirinhas estejam localizadas em areas
remotas e de dificil acesso, dificultando as atividades de fiscalizacdo (De Souza et al., 2023;
Padovezi, 2021). Essa situacdo também limita a obtencdo de dados concretos a respeito do
comportamento e caracteristicas dessas embarcacBes, 0s quais S30 €scassos.
Consequentemente, a falta de dados operacionais das embarcagdes regionais restringe as
analises técnicas e cientificas que possam contribuir no aumento da sua eficiéncia, seguranca e
sustentabilidade.

Com relacdo a seguranca das embarcagdes regionais, cabe mencionar que ainda é
necessario realizar estudos técnicos que permitam conhecer o seu comportamento. Algumas
recomendacOes foram propostas recentemente por Fontes et al. (2023), que apresentaram 0s
principais desafios que podem ter as embarcacdes de passageiros de longo percurso na regido
amazobnica. Constantemente podemos ver noticias de acidentes na regido amazonica
envolvendo embarcacdes ribeirinhas, como naufragio por embarque de &gua; colisdo com
embarcacdes maiores, rochas e bancos de areia; emborcamento ocasionado por banzeiros
(definigdo regional para “trens de ondas’) gerados por outras embarcacdes maiores (Soares et
al., 2023); entre outros.

Para entender como as embarcacdes regionais se comportam durante a navegacao, é
necessario acrescentar os levantamentos realizados em campo para conhecer dados de operagao

e desta forma, conseguir caracterizar o comportamento hidrodinamico delas.
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O presente trabalho visa conhecer a velocidade tipica e os padrdes de ondas gerados por
uma embarcacdo regional comum no Estado do Amazonas, conhecida como “rabeta”. A
embarcagao se caracteriza por ter um eixo saliente do casco (“rabeta’) que conecta o motor com
o hélice.

Foi feito um estudo experimental em escala real, visando medir a velocidade de avanco
com poténcia maxima do motor utilizando métodos baseados em GPS e processamento de
imagens. Alem disso, foi implementado um método computacional de hidrodinamica,
conhecido como método do corpo esbelto, para reproduzir os padrdes de onda visualizados

experimentalmente.

1.2 Revisao bibliogréafica

De acordo com Amaral et al. (2009), as rabetas substituiram as canoas em atividades
mais simples como deslocamento de grandes distancias e na pesca. O autor fez uma comparagéo
da utilizacdo entre os meios de transporte aquaticos e terrestres, afirmando que as rabetas séo
utilizadas nos rios tdo quanto as motocicletas séo utilizadas em terra-firme.

Segundo Oliveira (2014), existem em média um milhdo de embarcacgdes ribeirinhas em
circulagdo no interior da regido norte do Brasil. Estudos do mesmo autor afirmam que as
principais deficiéncias relacionadas a seguranca da navegacdo em embarcagdes ribeirinhas é a
inexisténcia de equipamentos basicos de salvatagem e de combate a incéndio, além da infracdo
como falta de habilitagdo pela tripulagao.

A partir de pesquisa realizada pela Defensoria Publica da Unido com comunidades
ribeirinhas do interior da regido norte do Brasil, constatou-se que acidentes como
escalpelamento sdo mais comuns em embarcac0Oes ribeirinhas entre 7 a 12 metros, onde utilizam
um motor de popa com rabeta que geralmente ndo possui a cobertura, ocasionando o acidente
(Oliveira, 2014).

No Amazonas, uma canoa com rabeta que levava cinco passageiros e navegava no Rio
Solimdes, colidiu contra uma balsa. O naufragio aconteceu no percurso entre a comunidade de
Caimbé e a Comunidade de Marajo, foi informado pelas autoridades que no momento da coliséo
a canoa se rompeu levando a obito 3 criangas (G1 AM, 2022).

Durante a navegacdo em um percurso rotineiro, uma pessoa teve sua embarcagédo
emborcada por banzeiros (termo regional para definir as ondas na superficie dos rios causadas
por alguma embarcacdo), provenientes de embarcacbes maiores que navegavam em alta

velocidade. Na regido amazoénica, sdo constantes os relatos de embarcacBGes que alagam ou
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emborcam durante a navegacgdo pois sdo atingidas por grandes banzeiros. Apos do acidente, a
passageira conseguiu nadar até a margem mais proxima; porém, a canoa afundou e o motor de
popa com rabeta ficou danificado (Pimentel, 2019).

E importante mencionar que as embarcacbes de pequeno porte tém um papel
fundamental na vida da populagéo ribeirinha, pois séo usadas principalmente para locomocao
e praticas comerciais, incluindo a pesca, impactando diretamente em aspectos sociais e
econdmicos.

Hernandez-Fontes et al. (2021) revisaram os desafios do transporte fluvial na regido
amazonica, propondo algumas alternativas para o transporte mais eficiente e sustentavel na
regido. Os autores ressaltaram a necessidade de inovar as embarcacdes regionais, seja por meio
de andlises técnicos e cientificos com conceitos de Engenharia Naval ou incluindo o
aproveitamento de energias renovaveis.

Maia e Said (2019) estudaram a hidrodindmica de uma embarcacdo regional de
transporte escolar utilizando fluidodinamica computacional. Posteriormente, Maia et al. (Maia
et al., 2021) estenderam esse trabalho para otimizar a forma do casco utilizando métodos de
redes neurais artificiais, aplicando fluidodindmica computacional para pesquisar os padrdes de
onda gerados, bem como a resisténcia ao avanco. Os resultados demonstraram que com simples
modifica¢Bes do casco, poderia se economizar combustivel ao longo prazo.

Soares et al. (2023) avaliaram os possiveis trens de ondas causados por uma embarcacéao
regional de transporte de passageiros, conhecida como “expresso”. Os autores utilizaram
métodos baseados na teoria do escoamento potencial para analisar, de maneira simplificada e
preliminar, os trens de ondas que poderiam ser causados pela embarcacao.

Favacho et al. (2016) propuseram um procedimento de selecdo de hélice para
embarcacdes de pequeno porte regionais da Amazoénia. Eles propuseram uma abordagem
matematica para o projeto de propulsores maritimos. Embora esse estudo ndo tenha sido
aplicado em trabalhos de campo, a analise demonstra o interesse da comunidade cientifica em

propor alternativas para melhorar o desempeno da navegacéo fluvial regional.

1.3 Justificativa

Embora existam alguns estudos relacionados com o comportamento de embarcagdes
tipicas na regido amazonica, como lanchas escolares (Maia et al., 2021; Maia; Said, 2019),
expressos (Soares et al., 2023), barcacas (Junior et al., 2023), flutuantes (Neto; Fontes; Maia,

2023), entre outras, pouco se sabe dos regimes de operacdo de embarcacdes conhecidas como
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“rabetas”. Essas embarcacdes sdo, muitas vezes, improvisadas a partir de cascos de madeira ou
aluminio, instalando um motor (que pode ser adquirido a baixo custo) e improvisando um eixo
saliente do casco (rabeta), para movimentar uma hélice de duas a trés pas comercializada na
regiéo.

Esses tipos de embarcag6es ndo tém sistemas de navegacdo que proporcionem a relagéo
de velocidade/poténcia do motor. A poténcia do motor é aplicada de maneira empirica por meio
de uma alavanca. O méaximo deslocamento lateral da alavanca proporciona maxima poténcia
operacional do motor.

Nessa condi¢do, pode-se definir qualitativamente a embarcagdo como “rapida”. Porém,
é necessario obter dados experimentais que permitam classificar o modo de operacéo baseado
no numero de Froude de comprimento que, segundo varios autores da area de Engenharia
Naval, € um numero adimensional que ajuda a classificar o regime de operacdo de uma
embarcacao, contribuindo na defini¢cdo de uma embarcacao de baixa ou alta velocidade.

Para contribuir com essas pesquisas, 0 presente estudo visa realizar experimentos com
uma embarcacao do tipo “rabeta” para determinar a velocidade tipica com a alavanca aplicando
a maior poténcia do motor. Além disso, pretendem-se obter evidéncias dos trens de ondas

gerados por esse tipo de embarcagdes.

1.4 Objetivos
1.4.1 Objetivo geral

Estudar de maneira experimental a velocidade de avanco e as ondas geradas por uma
embarcacdo regional do tipo “rabeta” através de métodos baseados em GPS e analise de
imagens obtidas por drone, discutindo os desafios que esse tipo de embarcacdes pode apresentar

na regido amazonica.

1.4.2 Objetivos especificos

- Realizar pesquisa de campo e elaborar um levantamento de embarcacdes regionais do
tipo rabeta, utilizadas na locomocao de comunidades ribeirinhas em diversas areas proximas a
cidade de Manaus.

- Realizar experimentos de campo para medigédo da velocidade de avanco e das ondas
geradas por uma embarcacao representativa do tipo rabeta, utilizando medicao por aplicativo

de celular com GPS e analise de imagens obtidas com drone.
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- Processar os dados obtidos no experimento de campo e obter as velocidades médias
de avanco considerando a poténcia do motor gerada pelo maximo deslocamento da alavanca de
controle.

- Com a velocidade obtida, caracterizar o regime de operacéo hidrodinamica baseada no
numero de Froude e realizar uma simulagdo numérica para comparar os trens de ondas obtidos
experimentalmente.

- Discutir os principais desafios que esse tipo de embarcacdes pode apresentar com

relacdo a operacdo cotidiana nas comunidades ribeirinhas da regido amazonica.

1.5 Estrutura do trabalho

O atual trabalho esté organizado no formato a seguir: o Capitulo 2 proporciona alguns
conceitos relevantes de fundamentacdo tedrica. No Capitulo 3 sdo descritos os métodos
utilizados e o Capitulo 4 apresenta os resultados obtidos com suas respectivas discussdes.

Finalmente, o Capitulo 5 sumariza as principais conclusdes encontradas.
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2. FUNDAMENTAGAO TEORICA
2.1  Modos de operacéo de embarcacdes

Uma embarcacgdo pode ser descrita como uma estrutura que pode ser feita com diversos
materiais, tendo como objetivo flutuar e ser impermeavel. A embarcacdo é capaz de se mover
sobre a superficie da agua, além de fazer o transporte de pessoas e cargas, resistindo as
intempéries sem sofrer deformidades ou rupturas permanentes (Augusto, 2007).

Existe uma grande variedade dos tipos de embarcaces existentes, entretanto, cada tipo
tem uma funcéo especifica que varia desde o transporte de grandes quantidades de carga até o
transporte de algumas pessoas.

Por isso, existem classificacbes do regime hidrodindmico em que as embarcacgdes
operam. Sob a perspectiva hidrodinamica, pode ser utilizado o ndmero de Froude de
comprimento (Fn.) para determinar o regime de operagdo em que a embarcacado se encontra

(Faltinsen, 2005). Para determinar o nimero de Froude, é usada a seguinte equagéo (1):

FoL =

Vv
N 1)
sendo:
Fa—NUmero de Froude de comprimento (adimensional);
V — Velocidade de operacdo (m/s);
L — Comprimento na linha d’agua (m);

g — Aceleracéo da gravidade (~9,81 m/s?).

De acordo com Faltinsen (2005), o nUimero de Froude é um OGtimo parametro
adimensional para categorizar o modo de operacao de embarcacdes, pois com ele relaciona 0s
efeitos das forcas gravitacionais com as forcas de inércia, as quais sao relevantes no movimento
de estruturas na interface dgua-ar. Sob esta perspectiva, 0s modos de operacao das embarcacdes
podem ser de trés tipos principais, segundo o numero de Froude de comprimento: deslocamento
(FnL < 0,4), semi-deslocamento (0,4-0,5 < Fn. < 1,0-1,2), e planeio (Fn. > 1,0-1,2).

Salienta-se que os limites das faixas de Froude ndo sao exatos, podendo haver transi¢oes
de comportamento hidrodindmico entre elas. Segundo Faltinsen (2005), uma embarcacéo
rapida, desde o ponto de vista hidrodindmico, pode ser definida com Fn_ > 0,4.

Nas embarcacdes que operam no regime hidrodindmico de deslocamento, 0s aspectos
dindmicos fora da agua interferem pouco com a sustentacdo da embarcacdo, visto que a

principal forca atuante € o empuxo, ocasionado por uma grande pressdo hidrostatica.
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Geralmente, esse modo de operagdo € comum em embarcacgdes de meio e grande porte, voltadas
para o transporte de carga e passageiros.

As embarcacdes que operam no regime de semi-deslocamento sdo embarcacdes mais
versateis, geralmente de porte médio e que operam com velocidades intermediarias. Nesse tipo
de embarcacdo as forcas hidrostatica e dindmica agem em conjunto, pois a proa da embarcacao
tende a sair mais da agua com relacéo a sua condicao de equilibrio hidrostatico. Suas aplicacdes
sdo as mais variadas, podemos visualiza-las em embarcacdes de passeio, transporte rapido de
pessoas e cargas, embarcacdes de apoio, embarcacfes de servigo entre outros.

As embarcacdes que operam no regime hidrodinamico de planeio, s&éo embarcagdes que
atingem altas velocidades e conseguem planear, mantendo sustentacao parcial com a superficie
da agua. Durante a operacéo, devido ao formato do casco, essas embarcacgdes desenvolvem altas
velocidades o que ocasiona uma pressédo dindmica positiva, e diminuigdo da forga empuxo.
Quanto mais répidas essas embarcagcfes, menos contato o casco pode ter com a agua. Suas
aplicacOes séo mais restritas, voltadas para recreio, embarcag6es de competicdes de velocidade

ou projetos especiais quem demandam altas velocidades.

2.2 Sistema de Posicionamento Global (GPS)

No presente estudo, foi utilizado um aplicativo de celular baseado em Sistema de
Posicionamento Global (GPS — Global Positioning System) para monitorar o0 movimento de
uma embarcacao.

O Sistema de Posicionamento Global (GPS) trabalha com o premissa da
triangularizacdo, onde é conhecida a posi¢cdo de um grupo de satélites em relacdo a um
referencial inercial (Maia, 1999). A localizacdo é definida a partir dos seguintes parametros:
R_u) é a posicdo do usuario; % é a posicdo do i-ésimo satélite; pf é a posicdo do usuario em
relagdo ao i-eésimo satélite, conforme figura 1.

Figura 1 - Principio basico do GPS.
7 GPSSV
9 X.Y.Z
P'S i ‘i
Receptor
X,Y,Z

Terra

Fonte: Adaptada de Maia, 1999.
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Segundo Maia (1999), admite-se a posicdo do usuario R, = (X,,,Y, , Z,), entdo aplica
a seguinte relago:
N 2 N 2 N 2 —2
Xy — X))+ (Y, — YD) + (z,— 2})" = pt )
onde cada um dos satélites i transmite sua posicao e o instante da transmissédo to. Na superficie
da terra, estdo posicionados receptores GPS que fazem a conversao dos sinais dos satélites em

posicdo, tempo e velocidade. Para determinar as posi¢oes X, Y, Z e 0 tempo t s80 necessarios

pelo menos quatro satélites em pleno funcionamento.

2.3 Medicao por processamento e analise de imagens

No presente estudo, utilizou-se uma técnica de processamento e analise de imagens
aplicada aos videos obtidos por um drone, para medir 0 movimento da embarcacdo. Foram
considerados os métodos disponibilizados nas publicacdes de Hernandez et al. (2018) e
Hernandez-Fontes et al. (2020a), que propuseram técnicas de medicdo de elevacdes de agua
baseadas em analise de imagens binarias (ou seja, imagens com pixels na cor branca e preta).

Os métodos e scripts proporcionados foram gerados para uso no software de livre acesso
ImageJ. O primeiro passo para implementar esses métodos consiste em obter as imagens, as
quais sdo processadas para obter a segmentacdo (ou separacdo) do objeto de interesse. Assim,
uma vez que a imagem original tenha sido segmentada por um limiar de cor ou espectro de
cores, é possivel o calculo das caracteristicas da forma dos objetos identificados, sendo possivel
gerar e salvar imagens binarias.

Em sequéncia, usando operacfes morfoldgicas (ou seja, operacdes aritméticas com 0s
conjuntos de pixels identificados na cor branca ou preta, a partir das imagens binarias), o objeto
de referéncia € filtrado do restante. Finalmente, o0 movimento do objeto de interesse é
monitorado, proporcionando dados numéricos da evolugdo da sua posicdo no tempo. Esses
dados séo traduzidos para interpretar o movimento do objeto de interesse.

O protocolo de processamento e analise das imagens pode ser definido mediante trés
etapas principais: (i) digitalizacdo de imagens, (ii) processamento de imagens, e (iii) analise de

imagens binarias. Cada uma das etapas é descrita a continuacao.

2.3.1 Digitalizacdo de imagens
Uma vez que o monitoramento do movimento € obtido pela gravacdo continua de

videos, é necessario extrair cada frame dos mesmos e exportar o conjunto de frames como
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imagens de formato PNG (Portable Network Graphics). O conjunto de imagens (stack) extraido
é salvo como um novo video processado. A partir desses novos videos, uma regido de interesse
é definida em todas as imagens do video, sendo criado e exportado um novo video, com area
de interesse reduzida, em formato TIFF. Esse novo arquivo é utilizado no processamento e

anélise de imagens.

2.3.2 Processamento de imagens

O processamento de imagens emprega inicialmente uma segmentagdo baseada em cor,
considerando um espaco de cor baseado no tom (H), saturagéo (S) e brilho (B) dos pixels na
imagem. Deste modo, sdo definidas as faixas de interesse de cada parametro, sendo possivel
segmentar apenas a regido descrita pelo objeto a ser monitorado. Isto é realizado assignando o
valor da intensidade de pixel, como 6 = 0, para elementos dentro das faixas dos parametros, e
0 = 1 para o restante dos pixels.

Para obtencdo de um conjunto (stack) de imagens binarias, ele deve ser gerado ap0s
converter imagens RGB-color para o tipo 8-bit. Posteriormente, usando a ferramenta de
limiarizacéo (thresholding) pelo método de Otsu, é possivel binarizar o conjunto de imagens.

As imagens binarizadas ainda precisardo da aplicacdo de operacfes de morfologia
binaria para recuperacao dos descritores de forma durante a analise de imagens. Assim, segundo
Hernandez-Fontes et al. (2020a), pode ser aplicada a operacdo close, que engloba uma
sequéncia de dilatacdo e erosao, resultando em um descritor de forma apropriado para o objeto

a ser medido.

2.3.3 Analise de imagens binarias

A analise do conjunto de imagens bindrias resultante do estagio de processamento €
realizada incorporando o fator de escala entre as unidades da imagem (pixel) e as unidades reais
(metros). Geralmente, isso pode ser feito assignando o comprimento do objeto (em metros) para
sua medida correspondente (em pixels) na imagem.

Com a escala definida como global, qualquer conjunto de imagens importado
considerara as mesmas propor¢oes. Assim, para analise do mesmo conjunto, ndo sera necessario
definir novamente esta proporcdo, uma vez que o arquivo TIFF multicamada salvara também

esta informagdo como metadados no conjunto.
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O seguinte passo, foi a definicdo das medidas requeridas para analise, onde
considerando que a sequéncia de imagens esta igualmente espacada um intervalo de tempo, ot,
€ necessario apenas a extracdo da posicdo espacial da forma do objeto.

Com a escala definida, o processo de analise a seguir é a definicdo das medidas
requeridas no stack de imagens. A descri¢do dos métodos de andlise e processamento utilizados
podem ser consultados na literatura publicada por Hernandez et al. (2018) e Hernandez-Fontes
et al. (2020a).

Durante a analise das imagens binarias, é necessario realizar operagdes morfologicas
sobre o conjunto de pixels identificado. No presente estudo, serd& mantido o foco na
identificacdo da forma da embarcacdo na forma de uma elipse.

As coordenadas do centro de massa dos objetos na cena se expressam em relacao da
origem O (0, 0) localizado no canto superior esquerdo da imagem. Assim, o centro de massa
(X, Y) de uma particula com N-pixels, Pj, é definido como o ponto G tal que:

i=N

T:%Zm ©)

i=1

E que:

X; = %Z X; 4)

S ©

onde X¢ e Yg fornecem, respectivamente, a localizagdo média dos pontos centrais dos
segmentos horizontais e verticais em uma particula.

No presente estudo, € assumido que a embarcacdo em movimento pode ser identificada
nas imagens binarias como uma elipse em movimento. O processo necessario para determinar
a relacdo espacial e temporal do objeto de referéncia (nossa embarcagdo) é realizado com a
ferramenta de analise de particulas nativa do software de livre acesso ImageJ (opcdo Analyze
> Analyze Particles...), selecionando na interface correspondente as propriedades da faixa de
tamanho, faixa de circularidade, e visualizacdo de elipses ajustadas.

Os resultados gerados da anélise de particulas sdo apresentados em modo tabular em
uma instancia dedicada dentro do software, permitindo exportar os mesmos nos formatos de

dados separados por coma (CSV) ou de texto (TXT). Para este estudo os dados foram
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exportados no formato CSV uma vez que é um formato nativo do programa Excel onde foi

finalizada a andlise dos resultados.

2.4 Trens de ondas

Quando uma embarcagdo se move através de um fluido, esta cria um sistema complexo
de ondas cujos padrdes variam com a velocidade. Os trens de ondas gerados sao compostos por
diferentes componentes que se sobrepdem constantemente.

Esse fendmeno resulta em padrdes de ondas primarios e secundarios, influenciados
pelos picos de alta e baixa pressdo ao redor do casco. O sistema de ondas primario refere-se a
regido onde ocorre a depressdo no nivel da dgua, causada pelo movimento da embarcacéo, que
se estende ao longo do casco (Molland; Turnock; Hudson, 2017a; Qian et al., 2022).

No sistema de ondas secundario, o qual pode ser exemplificado pelo sistema de ondas
de Kelvin, uma embarcacdo em movimento constante cria ondas em forma de V, com
semiangulo e direcdo especificos em relacdo ao eixo do curso da embarcacéo.

No regime de deslocamento e sem considerar efeitos do fundo, este fendbmeno pode
resultar na formacao de dois conjuntos distintos de ondas: o sistema divergente, que emerge da
curvatura do casco e se propaga diagonalmente em relagdo a direcao da embarcacdo, e o sistema
transversal, que se posiciona aproximadamente perpendicularmente ao curso da embarcagéo
(Do Nascimento, 2007; Faltinsen, 2005).

Os padrdes de ondas gerados podem ser alterados pelos efeitos de profundidade e de
variacdo da velocidade de avanco. Conforme uma embarcacdo aumenta a sua velocidade,

saindo do regime de deslocamento, o trem de ondas transversal tende a ser menos notavel.
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3. METODOLOGIA

O presente estudo foi realizado considerando trés fases principais de pesquisa, como
mostrado na Figura 2. Primeiro, foi feito um levantamento de embarcagdes regionais do tipo
rabeta, com o intuito de documentar exemplos de embarcacdes por meio de fotografias e dados
principais (Fase 1). O levantamento foi feito em comunidades ribeirinhas proximas a cidade de
Manaus, no Estado do Amazonas.

Para o desenvolvimento da Fase 2, foi selecionado um caso de estudo de embarcacgéo
do tipo rabeta representativa, para realizar medicGes experimentais em escala real. Para isso,
foram planejados alguns testes experimentais, visando obter informagfes de velocidade e
propagacdo das ondas geradas por meio de um aplicativo GPS e técnicas de analise de imagens
obtidas por drone.

Finalmente, com os dados de velocidade obtidos de forma experimental, foi possivel
desenvolver a Fase 3, na qual foi feita uma simulagdo computacional do trem de ondas gerado
pela embarcacdo na velocidade medida. Para isso, foi criado um modelo computacional
tridimensional do casco da embarcacdo, que posteriormente foi utilizado em software
computacional para andlise de hidrodindmica. Os resultados obtidos da simulacdo foram
comparados com os resultados medidos experimentalmente. A seguir, na Figura 2, sdo descritas

cada uma das fases consideradas no estudo.

Figura 2 - Fases principais do estudo.

Fase 1.
Levantamento de embarcactes

Fase 2.
Analise experimental

Fase 3.
Simulag&o computacional

Fonte: Elaborado pelo autor, 2024.

3.1  Metodos experimentais
3.1.1 Caso de estudo de embarcacao
Neste estudo foi selecionada uma embarcagéo do tipo rabeta que fosse representativa de

outras embarcac@es regionais ribeirinhas similares, com a finalidade de realizar experimentos
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em escala real para medir da velocidade de avanco e do trem de ondas gerados. A embarcagéo
escolhida foi nomeada como Am-I1, e consiste em uma canoa de madeira equipada com um

motor de popa e rabeta, como mostrado na Figura 3.

Figura 3 - Embarcacdo escolhida como caso de estudo Am-I.

Fonte: Elaborado pelo autor, 2024.

As partes principais da embarcacdo Am-I sdo mostradas na Figura 4. Essas partes séo
apenas representativas de outras embarcacdes similares, podendo variar o material do casco,
tipo de motor e nimero de pas do hélice. O motor de popa com rabeta consiste no motor que
tem seu eixo propulsor prolongado e externo a embarcagédo, ou seja, existe um tubo telescopico
ligado ao motor que abriga o eixo propulsor e no fim € instalado um hélice, proporcionando um
alongamento da posicéo do helice. Isso é fundamental para os ribeirinhos, pois eles navegam
as margens dos rios e lagos onde na maioria das vezes sao regides rasas.

Figura 4 - Partes principais da embarcacéo tipo rabeta que foi escolhida como caso de estudo.
Remo

e

Motor de popa

N

/

Rabeta

Hélice de duas pas /
/ Canoa de madeira

Fonte: Elaborado pelo autor, 2024.
As caracteristicas principais da embarcacdo Am-1 sdo mostradas na

Documento F559.D122.E0D2.03F2 assinado por: CLAUDIA TEIXEIRA DE SOUZA:897******* em 08/03/2024 as 12:16 utilizando assinatura por login/senha.



Folha: 201

25

Tabela 1, onde podem ser verificadas as dimensdes principais, lotacdo habitual e

poténcia do motor.

Tabela 1 - Caracteristicas principais da embarcacdo Am-I.

Dados da embarcacao Observagdes
Comprimento (m): 6 -
Boca (m): 1,2 -
Pontal médio (m): 0,40 -
Calado de operacéo Calado médio a meia nau sem considerar angulo
~0,25m . « . X
(m) de trim durante operacéo (até 3 passageiros)
Potenczzs)(? motor 55 Motor Rabeta de Popa — Toyama (TE55N-XP)
Lotacdo (numero de 6 )
pessoas):
Local de operacio Lago do A embarcacéo tamb,em pode sair do Iag_o para
_ - navegar em outras areas. Durante a estiagem
comum: Cacau Piréra . . -
apresenta dificuldades para sair da regido.
. i Manopla do A poténcia do motor é regulada por meio do
Sistema de governo: | motor rabeta
q deslocamento de uma alavanca manual.
e popa
. _ . Construida artesanalmente no mesmo local onde
Material do casco: Madeira . . .
foi realizado o experimento

Fonte: Elaborado pelo autor, 2024.

3.1.2 Lugar e procedimento de realizagdo dos experimentos

Os experimentos de campo foram realizados em uma comunidade as margens
do Rio Negro, mais precisamente as margens do Lago do Cacau, uma area localizada no distrito
Cacau Piréra, no municipio do Iranduba, Estado do Amazonas, Brasil. De maneira aproximada,
a localizacao central onde foi realizado o experimento é definida pelas seguintes coordenadas

de posic¢éo segundo o Google Earth: 3°09'04"S 60°07'31"W, de acordo com a figura 5.

Figura 5 - Local de realizacdo do experimento.

F 4

Local do Experimento

Fonte: Google Earth, 2024 (Editado pelo Autor).
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A Figura 6 ilustra a regido principal onde foi realizado o experimento, definindo uma
area aproximada de 25 m x 110 m na qual aconteceu a medicao de velocidade de avanco e do

trem de ondas gerado.

Figura 6 - Esquema representativo da area aproximada onde foi realizado o experimento.

Fonte: Elaborado pelo autor, 2024.

O procedimento experimental pode ser resumido como segue:

- Foram usados um aplicativo de celular com GPS e um drone posicionado acima do
campo de visdo definido na figura anterior. A intengdo foi capturar videos como o drone, para
um pds-processamento que permita obter informacdes da velocidade de avancgo e geracédo de
ondas. Os dados do GPS foram salvos para fins comparativos.

- Foram realizados varios pré-testes para verificar a correta medicdo dos sensores, sendo
utilizado um experimento para o estudo.

- As medic¢des foram obtidas durante a maxima capacidade de operacdo do motor. Isto
¢, mantendo o maximo giro da alavanca controladora de poténcia.

- Foi utilizada uma camera posicionada na beira do rio para documentar imagens

complementares, principalmente as relacionadas com a incidéncia das ondas com a margem.

3.1.3 Medicdo da velocidade de avanco pelo aplicativo com GPS

Para realizar a medicdo pontual da velocidade de avango abordo da embarcacao,
utilizou-se um aplicativo de celular marca iPhone 12, que utiliza um receptor movel de sinal
GPS e troca dados com pelo menos 3 satélites GPS para realizar a triangulacéo do sinal e indicar

diversos dados, como posicdo, velocidade, altitude etc.
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O aplicativo de celular se chama Speedometer e nele é observada uma interface simples
e clara, exibindo dados como velocidade instantanea com precisao do receptor mével GPS em
tempo real, além da rota e duracdo da viagem, como mostrado na Figura 7. O aplicativo foi
ativado durante todas as medigdes e os dados registrados foram analisados para fins

comparativos da velocidade do avanco.

Figura 7 - Interface do aplicativo Speedometer.

A PARADO
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Fonte: Elaborado pelo autor, 2024.

3.1.4 Medicdo de velocidade de avanco por analise de imagens obtidas por drone

De maneira complementar ao uso de aplicativo com GPS, foi utilizado um drone marca
DJI Mini 4 PRO para medir a velocidade de avancgo, o qual foi mantido em posicao estatica
acima do percurso da embarcagdo, visando capturar o0 movimento da embarcacéo e do trem de
ondas gerado na maxima poténcia aplicavel do motor, ou seja, com a alavanca de controle no
maximo giro.

A Figura 8 mostra um exemplo da captura do drone acima da trajetéria da embarcacéo,
posicionado a 100 m de altura com a camera apontando em 90° com relagdo ao plano da
superficie da agua.

Os videos obtidos com o drone foram utilizados para aplicar técnicas de medicdo de
movimento de objetos baseadas no processamento e analise de imagens bindrias, seguindo o0s
procedimentos descritos na fundamentacdo teorica e apresentados por Herndndez et al. (2018)
e Hernandez-Fontes et al. (2020a).

Nesses artigos, além dos conceitos matematicos, sdo disponibilizados alguns scripts de

livre uso para o software ImageJ. No presente estudo, apenas foram considerados os conceitos
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das referéncias consultadas, pelo que as fases de processamento e analise das imagens foram
feitas diretamente no ImageJ para quantificar o movimento da embarcacéo.

A Figura 8 mostra um exemplo da imagem capturada pelo drone incluindo o campo
completo de visdo (FOV, Field Of View). Nele, aparecem vérias regides definidas com “F”, as
quais representam algumas &areas com vegetacdo. Para o uso da técnica de medigdo de
movimento por meio de analise de imagens, foi considerada uma regido de interesse (ROI,

Region Of Interest), a qual foi a base para o processamento e analise das imagens.

Figura 8 - Defini¢do do campo de visdo e da regido de interesse para o processamento e anélise das imagens obtidas
pelo drone.

Fonte: Elaborado pelo autor, 2024.

Como descrito na fundamentacéo teorica, o protocolo de processamento e analise de
imagens para obter medi¢fes do movimento da embarcacdo (exemplo: velocidade), pode ser
definido mediante trés etapas principais: digitalizacdo de imagens, processamento de imagens,
e andlise de imagens binarias, como descrito por Hernandez et al. (2018) e Hernandez-Fontes
et al. (2020a).

Uma vez que o monitoramento foi obtido pela gravacdo continua de videos, foi
necessario extrair cada frame nos mesmos e exporta-los como imagens de formato PNG
(Portable Network Graphics). Para isto foi usado o programa de codigo aberto OpenShot
(https://www.openshot.org/) que permite edicdo basica em videos (Figura 9), bem como a
extracao dos frames de modo simplificado, mantendo a taxas de amostragem e compressao de
imagem consideradas durante a captura.
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Para extrair os frames dos videos, no momento de exportar o projeto, foi selecionado no

OpensShot a opcdo Image Sequence (Figura 10) deixando os parametros dos frames inicial e

final com os valores padrdo. Dentre as op¢Ges avancadas de perfil (Figura 10), foi selecionado

o perfil 4K correspondente ao dispositivo de captura DJI Mini 4 PRO, para uma taxa de

aquisicdo de aproximadamente 60 fps (frames per second) e uma resolugéo de imagens de 3840

x 2160 pixels.

Dentro das configuracdes de sequéncia de imagens foi definido como “-%05d.png”, isto

significa que cada imagem extraida serd nomeada com um sufixo idéntico, seguido de um hifen

e uma sequéncia de 5 digitos, e que o formato de imagem serd PNG.

Figura 10 - Extracéo e exportacéo dos frames dos videos capturados.

& Export Video X & Export Video ? X
File Name: [shipClassifier_EllipseOverlay File Name: [shipClassifier_EllipseOverlay
Folder Path: ‘D:/Temp/UF_Afaut Browse... Folder Path: ‘D:/Temp/UF_A/out Browse...

Simple

Advanced Options

simpe

Advanced Options

Export To: image Sequence | Ruofile
Start Frame: |1 = Profile: [4K UHD 2160p 60 fps (3840x2160)  |d
EndFrame: 2008 = || e 3540 3
Profile Height: [2160 |
AspectRatio: |16 = |s z
Image Sequence Settings spect Ratio: | :‘ ‘ :‘
Pixel Ratio: 1 H |1 :
Video Settings [ = =]
Frame Rate:  |60000 = [1001 =
Audio Settings
Interlaced: |No j

Image Sequence Settings
Video Settings

Audio Settings

0% 0%
Export Videa Cancel Export Video Cancel

Folha: 205

Fonte: Elaborado pelo autor, 2024.
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Com o conjunto de imagens extraido, foi usado o programa de codigo aberto ImageJ
(Schneider; Rasband; Eliceiri, 2012), distribuigéo Fiji (

File > Import > Image Sequence..., e alocando-as em um conjunto de imagens (stack).

Figura 11) seguindo a rota:

Figura 11 - Interface da distribuicdo Fiji do software ImageJ.
[5° (Fiji Is Just) Image) — [} b4
File Edit Image Process Analyze Plugins Window Help
O)o| x| <[t N A| 2| A| oo )sn]ur] g

lor picker 2565,255,255/0,0,0 (alt or long click for menu)

s|a| |»

Click here to search

Fonte: Elaborado pelo autor, 2024.

Assim, uma regido de interesse é definida (Figura 12) e ela é extraida no conjunto das
imagens seguindo as op¢des do menu Image > Crop. O conjunto de imagens resultante é entéo
exportado como um arquivo de imagem multicamada do tipo TIFF, seguindo as opgoes: File
> Save As > Tiff.

Figura 12 - Selecdo da regido de interesse do conjunto de imagens.
B (Fiji s Just) image = & X

| File Edit Image Process Analyze Plugins Window Help

olalo|/l«NAlp|e | wfs]u o] s8] |»

{Fiji Is Just) ImageJ 2.9.0/1.54f. Java 18.0_322 [64-bit]; il

Click here to searc

B 01 0083 Imsges (25%) - - )
411120 (DJI_0083-00140); 3840x2160 pixels. RGB. 3.7G8

| > | 1 2l

| [ DJI_0083 Images (25%) - a X ‘
| 37/120 (DJI_0083-00135). 3708X720 pixels; RGB; 1.2G8

(ML d o)
Fonte: Elaborado pelo autor, 2024.
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O processamento de imagens empregou inicialmente uma segmentacdo baseada em cor
(Image > Adjust > Color Threshold...). Para isto, foi considerado um espago de cor baseado
no tom (H), saturacéo (S) e brilho (B) dos pixels na imagem.

Deste modo, definindo as faixas de interesse de cada parametro como Hue [110, 227],
Saturation [21, 227], e Brightness [76, 246], foi possivel segmentar apenas a regido descrita
pela embarcacéo (Figura 13). Isto foi realizado assignando o valor da intensidade de pixel como
0 para elementos dentro das faixas dos parametros, e 1 para o restante dos pixels. A Figura 13
apresenta o resultado da segmentagdo na janela de detalhe. Embora as imagens do conjunto

aparentem ser binarias, estas apresentam apenas uma mascara sobreposta aos pixels originais.

Figura 13 - Segmentacéo de instancias baseada em cor.
[ (Fili & Just] image) o X

File Edit Image Process Analyze Plugins Window IHelv :
B olg|o| 2 <[ \|A| | O ] ofs]w] o] 4] 8] |»
(Fij s Just) Image] 2.9.0/1 54f, Java 18.0_322 [E4-tit] Click hers to search

[ DJI0082 images (75%) - o
281120 (DJI_0083-00127): 3708720 plkels; RGE: 12G8

Saturation

v Pass

I | 2

il I e

287120 (DJI_0083-00127), 3708x720 pixels; RGB; 1.2GB
|
T sl

Thresholding method: | Default hd

Threshold color. [Rea ]

olor space: |HSB v

¥ Dark background

anmall Flmreul Select | Bamplel

Stack | Macro | Help

| P |

Fonte: Elaboracéo propria baseada no software ImageJ, 2024.

Assim, para obtencdo de um stack de imagens binarias, foi feita uma conversao de
imagens tipo RGB-color para o tipo 8-bit (Image > Type > 8-bit), e posteriormente usando o
a ferramenta de limiarizacdo (thresholding) pelo método de Otsu, o stack foi devidamente
binarizado seguindo as op¢6es do menu Image > Adjust > Threshold..., como mostrado na

Figura 14.
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Figura 14 - Binarizacao do stack de imagens.

{Fiji Is Just) Imagel = O hreshold

File Edit Image Process Analyze Plugins Window Help

+
B o c|o| /<] [\|Alo|n| 4| ofsw|ur|s|s]a] |»
(Fiji Is Just) ImageJ 2.9.0/1.54f, Java 1.8.0_322 [64-bit]; Vd
%
[ DJI_0083_Images (75%) - O X 4l I
28/120 (DJI_0083-00127); 3708x7 20 pixels; 8-bit; 306MB ﬂ J j 138
=
[otsu ~||rec |
™ Dark background [~ Stack histogram
¥ Dontresetrange [ Rawvalues
# Auto | Apply | Reset| Set
gl | 3]

Fonte: Elaboragdo propria baseada no software ImageJ, 2024.

Os objetos binarizados ainda precisaram da aplicacdo de operacGes de morfologia
binaria para recuperacdo dos descritores de forma (Hernandez-Fontes et al., 2020b). Assim, foi
aplicada a operacdo Close, que engloba uma sequéncia de dilatacdo e erosdo, com um elemento
estrutural de 3x3 em 7 iteragOes, resultando em um descritor de forma apropriado para a
embarcacao.

A Figura 15 ilustra o resultado da recuperagédo do descritor de forma da embarcagdo,
para acesso as opgoes de operacdes deve seguir-se Process >> Binary > Options... no menu do

programa.

Figura 15 - Recuperacdo do descritor de forma da embarcacéo pela operagdo de morfologia binaria Close.

File Edit Image Process Analyze Plugins Window Help

+
B o|z|o| /|« |t A| o] J] oo |ur] o] 4] 6] |»
(Fiji Is Just) Imaged 2.9.0/1.54f; Java 1.8.0_322 [64-bit]: e Binary Options
[ DJI_0083_Images (75%) — O x | lterations (1-100): |7 |
28M20(DJ1_0083-00127); 3708x720 pixels; 8-bit (inverting LUT); 306MB Count (1-8) |1
[ = RESULTADO
PREE I” Black background
/z’ \\\ [~ Pad edges when eroding
’ \
’ \ EDM output | Owverwrite «

\

¢ Do |Cl -
ANTES ! _, ose

1

[¥ Preview

N 4 OK | Cancel| Help|

g1 i

Fonte: Elaboracdo prépria baseada no software ImageJ, 2024.
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A anélise do stack de imagens binarias resultante do estagio de processamento foi
realizada incorporando o fator de escala entre as unidades da imagem (pixel) e as unidades reais
(metros). Isto foi realizado assignando o comprimento da embarcacdo de 6 m para sua medida
correspondente (em pixels) na imagem, seguindo as opgdes Analyse > Set Scale... no menu,
como mostrado na Figura 16.

Com a escala definida como global, qualquer conjunto de imagens importado
considerara as mesmas propor¢des. Assim, para a analise do mesmo conjunto de imagens, ndo
sera necessario definir novamente esta proporgdo, uma vez que o arquivo TIFF multicamada
salvard também esta informacdo como metadados no stack.

O seguinte passo foi a defini¢cdo das medidas requeridas para analise, onde considerando
que a sequéncia de imagens esta igualmente espacada em um intervalo de tempo de 6t = 1/60 s,

foi necessaria apenas a extracao da posicdo espacial da forma da embarcacéo.

Figura 16 - Definigdo da relacdo de escala entre as medidas em pixel e as dimensGes reais em metros.

File Edit Image Process Analyze Plugins Window Help

O|o|c|o £ Al o|m| A ofs|uw| o] 4] a] |»
Wand (tracing) tool
[ DJ1_0083_Images (75%) — O % 2

28120 (DJI_0083-00127); 3708x7 20 pixels; 8-bit (inverting LUT); 306MB

Distance in pixels: |[151.4

Known distance:

]
Pixel aspect ratio:  |1.0
m

Unit of length:

”# Click to Remove Scale |

W Global pEgyLTADO
| Scale: 252333 pixels/m |

OK | Cancel| Help|

45 I

Fonte: Elaboragdo propria baseada no software ImageJ, 2024.

Com a escala definida, o processo de anélise a seguir consiste na definicdo das medidas
requeridas no stack de imagens. Para isto, no menu do ImageJ foi selecionado o caminho
Analyze > Set Measurements..., onde foram selecionadas as instancias de centro de massa

(Center of mass) e ajuste de elipse (Fit elipse), como mostrado na Figura 17.
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Figura 17 - Definicéo das medidas de analise necessérias.

I
¥ Set Measurements *

[~ Area [~ Mean gray value
[” Standard deviation | Modal gray value
[~ Min & max grayvalue [ Centroid

[ Center of mass [ Perimeter

[~ Bounding rectangle [+ Fitellipse

[ Shape descriptors [~ Ferets diameter
[” Integrated density [ Median

[~ Skewness I Kurtosis

[ Areafraction [~ Stack position

[ Limitto threshold | Display label

[V InvertY coordinates [ Scientific notation

[™ Add to overlay ™ NaM empty cells
Redirect to: |N0ne ﬂ
| Decimal places (0-9) ||
OK Cancel | Help
]

Fonte: Elaboracdo prépria baseada no software ImageJ, 2024.

O processo necessario para determinar a relacdo espacial e temporal do objeto de
referéncia (nossa embarcagdo) usou a ferramenta de anélise de particulas nativa do ImageJ, a
través da opcdo Analyze > Analyze Particle. Foram selecionadas as opgfes correspondentes as
propriedades da faixa de tamanho ([0,]), faixa de circularidade ([0,1]), e visualizacdo de
elipses ajustadas, como mostrado na Figura 18.

Figura 18 - Pardmetros da anélise de particulas binarias.
$ Analyze Particles X

Size (m*2). |0-Infinity
[ Pixel units

Circularity:  |0.00-1.00

Show:  |[i=lie1:3 -

Iv¥ Display results [ Exclude on edges
I¥ Clearresults I Include holes
™ Summarize [~ Overlay

[ Addto Manager [ Composite ROls
oK Cancel | Help

Fonte: Elaboragdo propria baseada no software ImageJ, 2024.

3.2  Simulacédo computacional

No presente estudo, foi realizada uma simulagdo numérica simplificada com a finalidade
de obter o padréo de ondas gerado pela embarcacdo, na velocidade de operagdo que foi medida
durante a anélise experimental. Para isto, a geometria do casco da embarcacdo selecionada
como caso de estudo foi modelada utilizando o software Rhinoceros 3D (versdo 8). A Figura
19 mostra algumas vistas do casco gerado, considerando as dimensdes e geometria do caso de

estudo.

Documento F559.D122.E0D2.03F2 assinado por: CLAUDIA TEIXEIRA DE SOUZA:897******* em 08/03/2024 as 12:16 utilizando assinatura por login/senha.



Folha: 211

35

Figura 19 - Vistas da embarcacdo modelada tridimensionalmente.

Fonte: Elaborado pelo autor com informagdes do software Rhinoceros 3D.

Posteriormente, o casco foi importado no software Maxsurf da Bentley Systems para
realizar a andlise das ondas geradas na velocidade de avanco correspondente. Para isto, foi
utilizado o método do corpo esbelto (slender body method) disponivel no software Maxsurf
Resistance.

Para o0 uso do método, foi necessario definir alguns parametros basicos, como calado e
velocidade de avanco da embarcacdo. Além disso, foi necessario definir parametros de
configuragdo da simulagdo, incluindo o tamanho da regido a ser considerada nos célculos e a
precisdo da integracdo. O método do corpo esbelto € um método que considera a teoria do
escoamento potencial para calcular, de maneira aproximada, as elevag¢@es da superficie livre da
agua devido a um corpo esbelto e simétrico em movimento.

Dessa forma, o escoamento é considerado como incompressivel e irrotacional. Detalhes
do método podem ser encontrados no Manual do Maxsurf Resistance (Bentley, 2020).
Recentemente, Soares (2023) apresentou algumas recomendacdes para o uso do software e a
selecdo de parametros para realizar analises adequadas, as quais foram consideradas no presente
estudo.
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4. RESULTADOS E DISCUSSOES
4.1 Levantamento de embarcaces regionais

No presente estudo, foram documentadas algumas embarcacdes regionais, proximas a
cidade de Manaus, que costumam ser, ou podem ser utilizadas como embarcacg6es tipo rabeta.
Os nomes originais das embarcac¢des ndo sao apresentados no presente documento, sendo eles
substituidos por letras.

A Figura 20 mostra a embarcacdo A, que foi construida e nomeada pelo proprietario,
um ribeirinho que viveu a vida toda as margens do lago do Cacau Piréra, comunidade situada
em uma afluente do grande Rio Negro. A embarcacédo € construida toda nas madeiras de louro
e de tanimbuca, comuns para construcao de canoas na regido. Ela esta equipada com 3 motores
a gasolina, totalizando 34 hp de poténcia, distribuidos como 2 motores na popa e 1 motor no
centro, conforme descrito na Tabela 2.

Em entrevista no local, o proprietario relatou usar a embarcacao principalmente para
realizar a pesca de peixes da regido amazonica, visto que a pesca € a principal atividade de
renda para a sua familia. Para realizar a pesca, muitas vezes o ribeirinho precisa se deslocar
grandes distancias a lugares indspitos.

Foi relatado que eram feitas viagens com 11 horas de duracgéo, partindo do Lago do
Cacau Piréra até o Lago do Igarapé Acu, nas proximidades de Novo Airdo. Nessas viagens,
aconteceram algumas situac@es de risco, como banzeiros (ondas) de grandes propor¢des, que

ocasionaram embarque de agua na canoa.
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Fonte: EIbrado pelo autor, 2023.

-

Tabela 2 - Caracteristicas da embarcagdo A.

37

Dados Observacoes
. i Material da embarcagdo: Madeira (Louro e
Comprimento (m): 9 X
Tanibuca)
Boca (m): 17 Sistema de governo: Leme manua! operado por
barra redonda no conves
. Rota: Lago do Cacau Piréra até Lago do lgarapé
Pontal (m): 0.7 Acu (Novo Airdo) — Periodo de 11 horas
Motor 1 (hp): 10 Motor Centro-Rabeta — Tanque 5L
Motor 2 (hp): 15 Motor Rabeta de Popa — Boreste
Motor 3 (hp): 9 Motor Rabeta de Popa — Bombordo
Lotacdo (Pessoas): 8 Uso: Longas viagens e pesca

Fonte: Elaborado pelo autor, 2024.

A segunda embarcacdo documentada (embarcacdo B) é apresentada na Figura 21 e tém

seus principais parametros descritos na Tabela 3. A embarcacdo navega nas aguas do Lago do

Anveres, comunidade ribeirinha que fica localizada no municipio do Careiro da Véarzea. Teve

seu casco comprado na cidade de Manaus, em um estaleiro de pequeno porte que fabrica cascos

de aluminio.

Em entrevista com o proprietario da embarcacdo, relatou-se que a canoa de aluminio é

o principal meio de transporte para todas as atividades que ele realiza durante o dia, seja para
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se locomover até a casa de parentes, para pesca, transporte de familiares ou lazer. A embarcacéo
estd equipada com um motor de popa com rabeta e poténcia de 6,5 hp, que € comum na regiéo,
e atende muito bem a demanda. Por ser um casco leve (fabricado em aluminio), ter quinas e um

formato esbelto, a embarcagdo B desliza muito bem nas guas calmas de lagos e rios.
Figura 21: Embarcacéo B.

o e W ==
Y < -w‘if
-

——

Fonte: Elaborado elo autor, 2023.

Tabela 3 - Caracteristicas da embarcacdo B.

Dados Observacdes
Comprimento (m): 6 Material da embarcacdo: Aluminio
Boca (m): 1,55 Sistema de governo: Manopla do motor de popa
Pontal (m): 0,5 Rota: Regido do Lago do Anveres
) Motor Rabeta de Popa — Modelo Honda Mega
Motor 1 (hp): 6,5 GX200
Lotacdo (Pessoas): 8 Uso: Locomocao local, pesca, lazer

Fonte: Elaborado pelo autor, 2024.

A Figura 22 apresenta a embarcacdo C (Tabela 4). Esse tipo de embarcagdo é nomeado
popularmente como ‘bote de aluminio’ e € muito comum entre os ribeirinhos no Lago do
Anveres. A embarcagdo consegue levar uma carga consideravel, transportando com seguranga

0s passageiros. Conta com um motor da marca Yamaha, de 15 hp de 2 tempos, e hélice de
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aluminio. O sistema propulsivo possui ajustes na posicdo de navegacdo, proporcionando a
opcao de navegar em adguas mais rasas nas epocas de estiagem (seca dos rios).

Em entrevista com o proprietario da embarcacdo, relatou-se que usa a embarcacao
principalmente para lazer e para deslocar sua familia pela comunidade. O proprietario
acrescentou também ter feito viagens de duragdo superior a uma hora; porém, ndo sentiu muita
seguranca na hora de enfrentar banzeiros maiores gerados por outras embarcaces.

Apesar do motor ndo ser tdo comum na regido devido a um custo elevado, o proprietario

ressaltou que é o motor ideal para esse tipo de embarcacdo, pois entrega bastante poténcia em

um baixo consumo de combustivel.

|-
==

Figura 22 - Embarcagéo C.

Fonte: Elaborado pelo autor, 2023.

Tabela 4 - Caracteristicas da embarcacédo C.

Dados Observaces
Comprimento (m): 6 Material da embarcacao: Aluminio
Boca (m): 1.44 Sistema de governo: Manopla do motor de
popa
Pontal (m): 0,47 Rota: Lago do Anveres — Lago Curari (1 hora)
Motor 1 (hp): 15 Motor de Popa — Modelo Yamaha 2T
Lotacdo (Pessoas): 7 Uso: Locomocéo local, lazer

Fonte: Elaborado pelo autor, 2024.
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A Figura 23 mostra a embarcagdo D (Tabela 5), a qual possui um casco pequeno e
esbelto. Pensada principalmente para alcancar altas velocidades, ela ndo tem a capacidade de
levar muita carga, tendo baixa capacidade de ocupacao de passageiros. Por ser uma embarcacédo
com dimensdes pequenas, ela entrega pouca estabilidade e exige certa expertise para pilota-la,
pois a qualquer sinal de desequilibrio dos ocupantes ela pode emborcar.

Esta equipada com um motor Honda de 6,5 hp, que d& resultados satisfatérios na
navegacao, permitindo que a canoa com motor de popa rabeta alcance 6timas velocidades,
consequentemente diminuindo o tempo dos percursos realizados.

Segundo relatos do proprietario, a embarcacdo Piaba do Anveres j& foi usada em
competicOes locais de corrida entre embarcacdes com motor de popa rabeta, atividade de lazer
no Lago do Anveres, onde na ocasido foi utilizado um motor de popa rabeta de 15 hp e alcancou
velocidades muito altas. Entretanto, o proprietario também relatou alguns contrapontos, como
a pouca estabilidade, ja que o casco da embarcacdo tinha pouco contato com a &gua devido a

velocidade elevada.
Figura 23 - Embarcacao D.
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Fonte: Elaborado peib autor 2023.
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Tabela 5: Caracteristicas da embarcacédo D.

Dados Observacoes

Comprimento (m): 4,2 Material da embarcacdo: Aluminio

Boca (m): 0,95 Sistema de governo: Manopla do motor de popa

rabeta
Pontal (m): 0,25 Rota: Lago do Anver_es — Porto da CEASA (45
minutos)
Motor 1 (hp): 6,5 Motor de Popa com Rabeta — Modelo Honda GX160

Lotacdo (Pessoas): 3 Uso: Locomocao local, lazer

Fonte: Elaborado pelo autor, 2024.

A Figura 24 mostra a embarcacgédo E (Tabela 6), comumente usada para navegacao aos
arredores de Manaus, principalmente para o transporte de suprimentos entre a cidade e casas
flutuantes. Foi construida com um casco em aluminio por um estaleiro de pequeno porte em
Manaus.

A embarcacao conta com um sistema de governo mais complexo onde foi instalado um
volante e manopla de velocidade, que permitem o controle do motor a partir do banco do piloto.
Porém, também é comum encontrar cascos similares com propulsdo do tipo rabeta. A
proprietaria relatou que a embarcacéo é agradavel na navegacéo, oferecendo boa estabilidade e

manobrabilidade durante percursos no Lago do Taruma.
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Figura 24: Embarcacdo E (nomeada

como Am-I para o caso de estudo).

Fonte: Elaborado pelo autor, 2023.

Tabela 6 - Caracteristicas da embarcacdo E.

Dados Observagoes
Comprimento (m): 4,2 Material da embarcacao: Aluminio
. Sistema de governo: Volante no painel de
Boca (m): 1,40 « .
controle e manopla de aceleracdo e velocidade
Pontal (m): 0,60 Rota: Lago do Tarumé — Flutuantes préximos
Motor 1 (HP): 30 Motor de Popa — Modelo Suzuki — DF30A 4T
Lotacdo (Pessoas): 8 Uso: Locomocdo local, Transporte de carga

Na Figura 3 foi mostrada a embarcacdo E (nomeada Am-1 para o presente estudo),
utilizada para locomocéo em uma pequena comunidade ribeirinha localizada nas margens do
Rio Negro, conhecida como Lago do Cacau Piréra. A embarcacdo em questdo foi escolhida
para o experimento de campo (ver fotos na Metodologia), e & denominada pelos habitantes da

comunidade como ‘canoa de madeira com motor de popa rabeta’, ela foi construida de modo

Fonte: Elaborado pelo autor, 2024.

empirico pelo proprio proprietario.
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A embarcacgdo é usada na locomocao local, acompanhando sempre as margens do Rio
Negro, onde desloca-se do Lago do Cacau Piréra até o estaleiro mais proximo para fins de
transporte de trabalhadores. A embarcacdo Am-I foi escolhida como caso de estudo
representativo devido a grande semelhanca com as embarcac¢Ges mais usadas pelos ribeirinhos,
portanto, obtém-se dados mais precisos da realidade dessas comunidades que dependem

principalmente do modal aquaviario para o dia a dia.

4.2  Resultados do estudo experimental

A presente subsecdao mostra resultados qualitativos da anélise experimental feita com o
drone. Basicamente, € mostrada a evolucéo da embarcacgao durante o trajeto no qual foi aplicada
a poténcia maxima ao motor e a velocidade foi medida. Cabe mencionar que foram feitos varios
pré-testes, visando obter as capturas com uma posicao adequada do drone.

A Figura 25 mostra detalhes do movimento da embarcacdo durante 8 segundos de
captura pelo drone, o qual foi posicionado em uma altura de 30 m, com a cdmera inclinada 90°
com relagdo ao plano d’agua utilizando como definic¢éo de brilho -8% e contraste de 75%. Na
figura, to representa o tempo inicial correspondente a primeira imagem mostrada. As imagens
subsequentes foram obtidas em incrementos de 0,2 s.

Nas capturas mostradas na Figura 25 pode se observar claramente o trem de ondas
divergente gerado desde a proa da embarcagdo, bem como os efeitos turbulentos gerados pelo
hélice. Pode-se verificar que ndo é formado o trem de ondas transversal pela popa, caracteristico
de embarcacdes em baixas velocidades (Molland; Turnock; Hudson, 2017b).

Figura 25 - Evolugdo do movimento da embarcacéo aplicando a carga méxima no motor. Existe uma diferenca de
2 segundos entre cada imagem.
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Fonte: Elaborado pelo autor, 2024.
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E importante ressaltar que o trem de ondas divergente gerado pela embarcacio se
propagou ao longe, interagindo com plantas e bancos de areia nas proximidades. A Figura 26
mostra a evolucdo da embarcacéo e do trem de ondas gerado, por meio de imagens obtidas pelo
drone em uma altura de 100 m e posicdo de 90° com relagdo ao plano horizontal utilizando
como definicdo de brilho -8% e contraste de 75%. Na figura, o intervalo de tempo entre cada
imagem é de 4 segundos, sendo to 0 tempo inicial da primeira imagem. Pode-se verificar a
extensdo que atinge o trem de ondas uma vez que a embarcacao alcangou o campo de visdo do
drone (t > to+32 s). Ainda depois desse tempo, o trem de ondas ainda continua evoluindo,
mostrando claramente o angulo de abertura com relacdo & coordenada longitudinal da

embarcagdo. Verifica-se claramente a auséncia do trem de ondas transversal.

Figura 26 - Evolugdo do movimento da embarcacao aplicando a carga méaxima no motor. Existe uma diferenca de

4 segundos entre cada imagem.
A

to+8s ) B to+12s

to+16s | to+20s
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to+40s | to+44s
Fonte: Elaborado pelo autor, 2024.

4.3 Medicéao da velocidade: resultados da analise de imagens

Os resultados gerados da analise do movimento da embarcacdo (anélise binaria) séo
apresentados em modo tabular em uma instancia dedicada dentro do software ImageJ, como
mostrado na Figura 27, permitindo exportar os mesmos nos formatos de dados separados por
coma (CSV) ou de texto (TXT). Para este estudo os dados foram exportados no formato CSV
uma vez que € um formato nativo do programa Excel onde foi finalizada a analise dos

resultados.
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Figura 27 - Resultados da analise das imagens binarias.

47

Results = O *
File Edit Font Results

\Label XM YM Major Minor Angle EI
E DJI-83 (bin-close)-2.1if:1 7316303 636041 285038 075767 3.22104
2 DJI-83 (bin-close)-2 1if 2 7313592 635947 287449 (075480 323819
3 DJI-83 (bin-close)-2 1if:3 7310056 635487 284470 (075356 347967
4 DJI-83 (bin-close)-2 1if 4 73.07195 635231 287599 (075510 349532
5 DJI-83 (bin-close)-2 tif 5 7301522 634889 284269 075691 349660
6 DJI-83 (bin-close)-2 1if:6 7297722 634395 287180 075411 344741
7 DJI-83 (bin-close)-2.4if:7 7296417 634348 289620 073604 341554
8 DJI-83 (bin-close)-2 1if & 7292109 634073 287570 075170 347196
9 DJI-83 (bin-close)-2 1if 9 72.88981 633267 291327 075299 337978
10 DJI-83 (bin-close)-2 1if: 10 7283766 632709 287646 073150 315780
‘1‘1 NILA3 (hin-rlnee).2 tif 11 7280710 A 32521 2 BG125 n74and4 3 27RAN |4:‘

Fonte: Elaboracdo propria baseada no software ImageJ.

Dos resultados exportados (ver figura anterior), as colunas XM e YM definem a posi¢éo

espacial do centroide da embarcacdo, com relacdo a origem da imagem, e as colunas Major,

Minor e Angle se referem, respectivamente, aos diametros maior e menor da elipse, e o angulo

de guinada (yaw) instantaneo da embarcacdo (angulo com relacéo ao eixo vertical que passa

pelo centroide da elipse). Assim, o calculo da velocidade da embarcacao foi realizado como
v(t) = {s(t + 6t) — s(t - ot)}/{256t}, onde 6t = 1/60 € intervalo entre os pontos t e t+3t, ou t-ot e t.

A Figura 28 mostra a evolugdo no tempo das velocidades no eixo x e y (VX e Vy,

respectivamente) medidas durante a andlise de imagens. Os dados incluem a velocidade

resultante, Vr, a qual foi calculada como Vr = (Vx2 + Vy?)%5, Percebe-se que existem oscilacdes

entre ambas as componentes de velocidade instantanea; porém, a oscilacdo permanece ao redor

de 4 e 0,1 m/s para VX e Vy, respectivamente.

Figura 28 - Resultado da velocidade instantanea em relacdo ao tempo a partir da analise de imagens.
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5 10 15
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Tempo (s)

Fonte: Elaborado pelo autor, 2024.
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Para determinar as velocidades médias da embarcacdo durante o trajeto, foram plotados
histogramas de frequéncia em um grafico de Vx em relacdo a Vy na Figura 29. Pode-se verificar
uma velocidade meédia de 3,92 m/s e 0,13 m/s na coordenada horizontal (Vx) e vertical (Vy),
respectivamente.

Considerando esses valores, pode-se calcular a velocidade meia resultante no trajeto
medido como Vr = 3,902 m/s, que proporciona um numero de Froude de comprimento de Fn.
= 0,508, que caracteriza a embarcacdo no modo de operagédo de semi-deslocamento. Desde uma
perspectiva hidrodinamica e segundo Faltinsen (2005), a embarcagdo pode ser considerada
como rapida (Fn. > 0,4).

Figura 29 - Resultados de velocidade média da embarcacéo.

1.0
0.8
0.6 4

°

0.4

0.2 e

4 <
OO_' o oo

V, (m/s)

-0.2 o o¢

] V,=3.92m/s
-0.4 4 V,=0.13 m/s
-0.6 4

-0.8 4

-1'0.""|""I""I""I""I""

V, (m/s)
Fonte: Elaborado pelo autor, 2024.

A Figura 30 mostra, de maneira complementar, os dados das componentes da aceleragéo
instantdnea ao longo do tempo, sendo Ax e Ay, e Ar a aceleracdo no eixo X, Yy, e resultante,
respectivamente. A aceleracdo foi calculada derivando a velocidade com relacdo ao tempo,

seguindo a mesma abordagem utilizada para a determinacéo da velocidade.

Folha: 224
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Figura 30 - Resultado da aceleracéo a partir da analise de imagens.
150

° Ax (m/s2)

100 L Ay (m/s2)
[ Ar (m/s2)

50 4

Aceleragdo (m/s2)

-50 -

-100 L
0 5 10 15 20 25 30 35
Tempo (s)

Fonte: Elaborado pelo autor, 2024.

Finalmente, a Figura 31 mostra a evolugdo do angulo de guinada da embarcacdo ao
longo do tempo. Pode-se verificar que esse angulo oscilou entre -4° e 3° durante o trajeto, 0 que
significa que a embarcacdo manteve uma trajetdria quase reta dentro do campo de visdo da

camera, com pouco giro da proa no plano horizontal.

Figura 31 - Evolucéo do angulo de guinada (yaw) instantaneo da embarcagéo ao longo do tempo.
3

N

— Guinada (graus)

[ B

Angulo de guinada (graus)

2
<.3
-4
_5I....:....:....:....:....:....:....
0 5 10 15 20 25 30 35
Tempo (s)

Fonte: Elaborado pelo autor, 2024.

4.4 Medicéo da velocidade: resultados do aplicativo de celular

Para complementar e comparar a medicdo da velocidade da embarcacao, foi utilizado o
aplicativo de celular Speedometer, um recurso destinado para 0 monitoramento de velocidade
de diversos meios de locomogéo, como apresentado na Metodologia. No presente estudo, foram
obtidos dados de velocidade instantdnea em cada ponto do percurso. A Figura 32 mostra o

registro completo do aplicativo, o qual foi ligado durante todos os testes experimentais.
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Figura 32 - Registro do aplicativo no experimento de campo.
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Fonte: Elaboracdo propria baseada no aplicativo Speedometer, 2024.

Conforme mostrado na figura acima, sdo evidenciados os dados de velocidade a cada
segundo que se passa durante o percurso, e a partir disso os dados foram exportados para o
software Excel onde foi gerada uma tabela e um gréfico desses dados.

Cabe mencionar que no presente estudo apenas foi considerado o caso em que a
embarcacao estaria com o motor na maior poténcia possivel pela acdo da alavanca, como
descrito na Metodologia. A Tabela 7 e a Figura 33 mostram os resultados obtidos para o trajeto
considerado para analise, o qual tambem foi definido para a analise pelo drone. As velocidades
obtidas a partir do aplicativo foram em quilémetros por hora, porém, uma visualizagdo mais
precisa da velocidade média, foi convertida em metros por segundo.

Pode-se verificar que a velocidade média foi de 4,07 m/s, a qual estd muito proxima a
velocidade média obtida pela anélise de imagens do drone. Essa velocidade proporciona um
numero de Froude de comprimento FnL = 0,53, que também permite classificar o modo de

operacdo da embarcacdo como semi-deslocamento.

Documento F559.D122.E0D2.03F2 assinado por: CLAUDIA TEIXEIRA DE SOUZA:897******* em 08/03/2024 as 12:16 utilizando assinatura por login/senha.



Folha: 227

Tabela 7 - Evolucdo da velocidade instantanea da embarcacdo medida pelo aplicativo de GPS do celular.

Hora Te(rsn)po Velo(%' gi?ael ;I rilsr;[]zm;anea Velocidade Instantanea (m/s)
09:30:40 0 15 4,17
09:30:41 1 15 4,17
09:30:42 2 15 4,17
09:30:43 3 14 3,89
09:30:44 4 15 4,17
09:30:45 5 15 4,17
09:30:46 6 14 3,89
09:30:47 7 15 4,17
09:30:48 8 15 4,17
09:30:49 9 15 4,17
09:30:50| 10 15 4,17
09:30:51| 11 13 3,61
09:30:52| 12 15 4,17
09:30:53| 13 15 4,17
09:30:54| 14 15 4,17
09:30:55| 15 15 4,17
09:30:56| 16 15 4,17
09:30:57 17 15 4,17
09:30:58| 18 15 4,17
09:30:59| 19 15 4,17
09:31:00( 20 15 4,17
09:31.01| 21 15 4,17
09:31:02| 22 15 4,17
09:31:03| 23 15 4,17
09:31:04| 24 14 3,89
09:31:05| 25 15 4,17
09:31:06| 26 15 4,17
09:31:07| 27 14 3,89
09:31:08| 28 15 4,17
09:31:09| 29 14 3,89
09:31:10| 30 15 4,17
09:31:11| 31 15 4,17
09:31:12| 32 15 4,17
09:31:13| 33 15 4,17
09:31:14| 34 14 3,89
09:31:15| 35 15 4,17
09:31:16| 36 15 4,17
09:31:17| 37 14 3,89
09:31:18| 38 14 3,89
09:31:19| 39 15 4,17
09:31:20| 40 14 3,89
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09:31:21 41 15 417
09:31:22| 42 14 3,89
09:31:23| 43 14 3,89
09:31:24| 44 14 3,89
09:31:25| 45 13 3,62
Velocidade 14,65 (km/h) 4,07 (mls)

Fonte: Elaboracéo propria baseada nos dados do aplicativo Speedometer.

Figura 33 - Resultado da velocidade instantanea ao longo do tempo.
Velocidade Instantdnea x Tempo
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Fonte: Elaborado pelo autor, 2024.

45  Comparacao de resultados experimentais com numéricos

A Figura 34 mostra a comparagdo dos resultados obtidos no levantamento de campo
(imagem capturada pelo drone) e os resultados da simula¢do numérica feita com o método do
corpo esbelto, disponivel na versdo académica do Maxsurf Resistance.

Os parametros usados para a simulacdo foram: calado médio de 0,25 m, velocidade de
avango de 7,7 nos (4 m/s; Fn. = 0,539), grade transversal de 300, grade longitudinal de 200,
precisdo de integracdo de 90001, e exagero vertical de 1. InformacGes adicionais dos efeitos
desses parametros podem ser consultados em Soares (2023) e Soares et al. (2023). Cabe
mencionar que foi considerada uma velocidade intermediaria de 4 m/s, a partir dos resultados
obtidos pela medicédo da velocidade média pelo aplicativo GPS e a analise de imagens do drone.

Pode-se observar de maneira qualitativa que os padrdes de onda simulados s&o muito
parecidos aos do experimento, principalmente tomando como referéncia o angulo de abertura

da geracdo do trem de ondas divergente com relagdo a linha central da embarcacdo, de
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aproximadamente 7,5°. Perto da embarcacéo, pode ser observado que, em ambos os resultados,
existe um numero similar de cristas. Longe da embarcacao, percebe-se que as ondas diminuem
0 seu comprimento em ambas as comparagoes.

Outro fato importante a ser notado é a auséncia do trem transversal que é gerado pela
popa da embarcacdo nos dados experimentais, devido possivelmente ao regime de semi-
deslocamento da embarcacdo, definido por um numero de Froude maior do que 0,4 (Fn. =
0,539). Lembrando que nos padrdes de ondas de Kelvin, que sdo tomados como referéncia nas
analises, sdo observados os sistemas e ondas transversal e divergente em condicGes de
deslocamento e sem considerar efeitos da profundidade.

Na simulacdo € possivel visualizar parcialmente esse trem transversal, porém, com
amplitudes de onda muito baixas, possivelmente devido as caracteristicas do método do corpo

esbelto para calcular a elevagdo das ondas nessa regiao.
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Figura 34: Comparacdo do trem de ondas divergente obtido experimentalmente com os
Fonte: Elaborado pelo autor (acima) e versdo académica do software Maxsurf Resistance (embaixo), 2024.

resultados da simulacdo feita com o método do corpo esbelto.
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46  Desafios encontrados

A presente subsecdo mostra alguns desafios ambientais encontrados durante a pesquisa
de campo. Espera-se que as evidéncias apresentadas possam contribuir para acrescentar as
pesquisas que visem melhorar a qualidade de vida das comunidades ribeirinhas e a0 mesmo
tempo diminuir os impactos ambientais.

O primeiro desafio esta relacionado com a geragdo de ondas por embarcacdes, as quais
tendem a aumentar a sua amplitude quando se aproximam aos bancos de areia, uma vez que a
embarcacao passou. No presente estudo, foi colocada uma camara na beira do rio, para capturar
a evolucgéo do sistema de ondas divergente, como mostrado na Figura 35, na qual to corresponde
ao tempo inicial da captura.

Verifica-se que antes de 12 segundos, quando a embarcacdo ainda esta visivel na
imagem, ndo existe amplificacdo da superficie da &gua na margem do rio. Porém, depois de 17
segundos, uma vez que a embarcacdo nao estd mais visivel, a elevagdo da onda comecou a
aumentar significantemente, apresentando efeitos de refracdo durante a interagdo com o banco
(to+28 3).

O aumento da amplitude pode se dever a reducdo de profundidade ou bem, aos efeitos
de refracdo gerados com a beira do rio. Esse processo de ida-volta pode contribuir com efeitos

de danificagdo das margens dos rios.

Figura 35 - Exemplo da interagdo dos trens de ondas com o banco de areia na margem do rio, logo apés de
passar a embarcagao.

to | J tot+4s

to+125 375 S t+175
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to+205 | to+285
Fonte: Elaborado pelo autor, 2024.

Cabe mencionar que os experimentos foram realizados na época da estiagem (més de
dezembro de 2023), pelo que foi possivel observar o aspecto das margens do rio, como
mostrado na Figura 36. Nessa figura, € possivel inferir que as raizes das arvores contribuem na

firmeza do solo, ajudando possivelmente a reduzir os efeitos de eroséo.

loe

Figura 36 - Aspecto das raizes das arvores que sujeitam
T A % i 53 AR TR ; £ E

=l

judam a prevenir a erosdo.

Fonte: Elaborado pelo autor, 2024.

A Figura 37 mostra algumas capturas obtidas pelo drone, que evidenciam os efeitos da
estiagem na regido na qual foi desenvolvido o presente trabalho. Pode se observar que a
presenca de dunas e lama, assim como de vegetacdo abundante, podem ser desafios que
precisam ser considerados para a operacdo segura de embarcacGes rapidas utilizadas nas

hidrovias da regido amazonica.
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Figura 37 - Imagens ilustrativas da regido préxima a area onde foi realizado o experimento, afetada parcialmente
pela estiagem.

Fonte: Elaborado pelo autor, 2024.

Durante a presente pesquisa, foi verificado que um dos principais problemas no
rendimento do sistema propulsivo foi o efeito da flora existente no rio com a rotagéo do hélice,
como pode ser visto na Figura 38. Varias vezes, as plantas ficaram presas entre o eixo e o hélice,
diminuindo a sua capacidade de empuxo, mesmo tendo a alavanca do motor ativada para gerar
méaxima poténcia.

Figura 38 - Exemplo do impacto que pode causar a flora dos rios no hélice das embarcagdes.

Fonte: Elaborado pelo autor, 2024.
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5. CONSIDERACOES FINAIS

O presente trabalho foi proposto para contribuir com o entendimento dos desafios que
apresenta 0 uso de embarcac¢des na regido amazonica. Foi considerado o caso de estudo de
embarcacdes regionais de pequeno porte conhecidas como rabetas, que sdo comuns no
transporte entre comunidades ribeirinhas e cujas caracteristicas hidrodinamicas tém sido pouco
documentadas na literatura.

A partir do levantamento de embarcaces realizado, foi possivel documentar imagens
de embarcacdes tipicas, descrevendo as partes principais de uma embarcacgéo do tipo rabeta. Os
resultados do estudo experimental feitos com uma embarcacdo representativa permitiram
documentar a velocidade média e os padrdes de onda tipicos que uma embarcacdo do tipo
rabeta, de caracteristicas similares, poderia apresentar.

As andlises consideraram 0 modo de operacdo empirico utilizado pelos operadores das
embarcagdes para acionar o motor. Considerou-se a situacdo de maxima poténcia permissivel,
aplicada pelo méximo deslocamento de uma alavanca de controle.

Os resultados experimentais indicaram que, em maxima poténcia, a embarcacao
estudada pode alcancar uma velocidade de avanco meédia entre 3,902 e 4,070 m/s,
correspondendo a nimeros de Froude de comprimento de 0,508 e 0,530, respectivamente. Esses
numeros permitem classificar o regime de operacdo hidrodindmica dessa operacdo como semi-
deslocamento, sendo considerada como uma embarcacao rapida.

Foram comparados os resultados numericos e experimentais relacionados com o sistema
de ondas gerado pela embarcacdo. Verificou-se uma representacdo bastante aproximada pelos
resultados numeéricos baseados no método do corpo esbelto. Observagbes experimentais
evidenciaram a interacdo que os trens de ondas gerados por embarcagdes similares podem
causar nas margens dos rios.

Finalmente, foram discutidos alguns desafios, encontrados durante o trabalho de campo,
que as embarcacOes regionais podem apresentar. Em resumo, a estiagem, interagdo de plantas
com o propulsor, e a presenca de bancos de areia, sdo alguns dos obstaculos que precisam ser
considerados nas iniciativas de melhora de embarcag6es regionais.

Sugere-se que o presente estudo seja estendido para avaliar os efeitos das ondas geradas
pelas embarcacdes nos bancos de areia ou em outras embarcacdes por meio de métodos
computacionais que considerem os efeitos de aguas rasas e escoamento Viscoso.

Também, propbe-se que a identificacdo de desafios que as embarcacBes regionais

apresentam na Amazonia seja estendida, criando alternativas de melhora por meio de mais
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estudos técnicos e cientificos. Espera-se que o presente trabalho possa contribuir com o

desenvolvimento de embarcacdes regionais mais eficientes, seguras e sustentaveis.
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